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Public. Great coffee, yummy snacks, and
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Debbie Jones on Microsoft Office 2007
Debbie Jones returns to share her knowledge of Office 2007 with us. She
will show us the changes in this newest incarnation of Microsoft’s
productivity suite, which comes in eight different combinations that all
contain familiar applications such as Word, Outlook, and Excel, while
some versions also include PowerPoint, Access, Publisher, and other
business-related applications. Debbie will address applications primarily
of interest to the home and small business user, with the main emphasis on
using Word.

If you need help understanding and navigating around this strange new-
looking world of “Ribbons,” “Office Buttons,” “Live Previews,” “Smart
Art,” and other unfamiliar stuff,  Debbie will give us lots of hints and to
warm us up and ease us into Office 2007 with confidence!

Debbie is a professional computer trainer and speaker. With degrees in
Electronic Engineering Technology and Business Administration, she brings
with her more than 20 years of computer experience. Her down-to-earth
approach to training will give you an edge on learning. Debbie is a source
of knowledge for many different computer programs, and additional subjects
such as leadership, communication, and assertiveness training. Her excellent
communication skills and open passion for what she does makes her one of
the best computer trainers and public speakers on the Peninsula and
throughout the United States. Her energetic, positive style of teaching will
empower you to conquer any hesitation you may have to understand and
use Office 2007.

Questions in advance? Contact Debbie at Debbie@debbteaches.com, or
phone (831) 372-4401 (cell 402-1810).�

Need Some Tricks to
Improve Your Cat

(and Human) Digital
Photos to make
them Cute, Cute,

CUTE?

Check out Regina’s
O’Reilly Book Review

on page 7!
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Open Volunteer Positions Available Now at MBUG !

MBUG-PC BOARD OF DIRECTORS
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Advertising information contact: Regina at
ReginaDoyle@aol.com.
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THINGS, THINGLETS
& THINGASSOS

S. Jack Lewtschuk
MBUG-PC
Columnist
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The First Computer Available
to the General Public

Type: Personal Computer
Released: August 12, 1981

Discontinued: April 2, 1987
Processor: Intel 8088 @ 4.77 MHzMemory: 16 KiB

~ 640 KiBOperating System: IBM BASIC / PC-D
OS 1.0 CP/M-86 UCSD p-System

By the way, this computer and I share birthdays—well,
perhaps a couple of years apart ☺!

TALKING ABOUT BIRTHDAYS …
THE PDA IS ELEVEN YEARS OLD
The first commercially successful personal digital
assistant (PDA), the Palm Pilot, was manufactured by

Palm Computing, (originally a division of US
Robotics) eleven years ago this month. A trademark
infringement suit filed by the Pilot Pen Corporation
against the company resulted in the hand-held devices
being referred to as Palm Connected Organizers from
1998 on. However, the term “palm pilot” has become
synonymous with PDAs, be they Palm or any other
brand.

AND PERHAPS YOU’VE HAD A FEW
BIRTHDAYS YOURSELF?
For the two or so MBUG members who might be old
enough to need this information, here is a website which
gives you a few suggestions about having a safer home
from the American Association of Retired Persons: http:/
/www.aarp.org/families/home_design/rate_home/

HOW TO REDUCE THE SIZE OF A PHOTO
There are many ways to reduce the file size of an image.
However you do it, you should always copy your original
photo at a smaller file size and use this copy to e-mail.
You can also use a smaller version of a photo to put
onto portable devices (Video iPod, pocket PC device,
flash drive, etc.), to save space. Also, I suggest you first
save your original photos in JPG, which is the most
common format used by digital cameras. If you have
TIF or RAW images, use the “Save As” or “Export”
features in your photo editing software to convert them
to the much smaller JPG format.

Many of us have compression options already installed
on our computers as part of Microsoft Outlook or
Office. Any photo editing program will be able to do
these actions, including the software that came with your
digital camera.  If necessary there are free tools you can
download.

Before we start, let’s settle some definitions—this gets
confusing because when you hear “size,” it sometimes
means the dimensions of an image (e.g., 640 x 480
pixels, 6 x 10 inches, etc.), or it can mean the file size of

HAPPY BIRTHDAY PC!

NOTE: Whenever you edit an
image, be careful NOT to
overwrite your original full-sized,
high quality file. It’s easily done
so make sure you have a
backup of all your pictures.
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the image (1MB, 4.4MB, etc.). To be consistent
throughout this article “dimension” means the height
and width of an image, while “size” refers to the file
size of the image.

Reducing File Size with Outlook
Recent versions of Outlook have a quick and easy way
to reduce the file size of images you want to e-mail
without changing the original photo. Find the images
you want to send in Windows Explorer, right click on
one or more of them and choose “Send To,” and “Mail
Recipient.”

You’ll see an option pop-up that offers to make all the
pictures smaller or keep the original sizes. Click on
“Show more options” to see dimension choices: “Small
640x480,” “Medium 800x600,” or “Large 1024x768.”

When you click “OK,” a copy of the image is made with
the reduced dimensions, and then added to your e-mail
message as an attachment. The file name stays the same
as the original, but the size will be smaller. From this
point, it’s just like sending any other e-mail—you add
your message and address, and click “Send.”

Reducing File Size with Other Programs
If you don’t use Outlook, there are tools in recent
versions of Office and other photo editing programs that
will help you reduce the file size of an image.

Microsoft Picture Editor comes with Office 2003 and
has a basic set of tools that you can use to shrink an
image. Most other photo editing programs have similar
options, with slightly different names and varying
options. Right-click on an image and choose “Open with
Microsoft Office Picture Manager.” Or open the
program, and then open the image. The first thing you
should do is click on “File,” “Save As,” so you know
you’re working on a copy of the file not the original.

Three features you can use to reduce the size of an image
under the “Picture” menu are:

Crop - this lets you remove unwanted elements from
the sides of an image.

Resize - use this to change the dimensions of an image
to a smaller form. You can change the image to a pre-
defined size, a set height/width or as 50 percent of the
original. It’s best to retain the proportions of the
original (otherwise you can get some screwy-looking
people and objects), so I usually stick with the
“Percentage of original” option.

Compress - this is a combination of reducing the
image quality and forcing the image to a pre-defined
size. It’s good for a quick job, but best avoided if you
want to have more control over the result.

File /Export - lets you save a copy of the image and
change the JPG quality settings to a lower standard
which will reduce the file size.

Microsoft Word also offers options to crop, re-size and
compress photo images. You can write an e-mail
message in a Word document then copy it to your e-
mail program. Or create your message in Outlook using
Word as your e-mail editor.

QT (QUICK TIP)
How to get to “System Properties” quickly: press the
“Windows” and the “Pause” key (keep looking).

298 MILLION BROADBAND USERS
According to the market research group Point Topic,
the number of broadband Internet subscribers worldwide
has hit 298 million, as of March 2007. In the United
States alone, there are 60.4 million broadband
subscribers, making us the largest broadband community
in the world.�                               blacklion@royal.net

ARE YOU A REGISTERED MBUG LISTSERV MEMBER YET?
Join the MBUG listserv and send messages to all other MBUG Members and have other Members reach
you with important information:� It’s secure (messages are monitored by MBUG’s Webmaster ensuring

messages are computer-related, virus-free and sent by Members only — no outsiders, no spammers!)
� Get current MBUG announcements � Get up-to-date virus & scam warnings � Ask and

answer computer-related questions  � Make computer-related  announcements
Register at www.mbug.org or go to http://listserv.redshift.com/mailman/listinfo/mbug
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STAR REIERSON ON PREVENTATIVE
SYSTEM MAINTENANCE
At the General Meeting on July 6, MBUG Workshop
Leader Star Reierson covered a variety of ways to
maintain our PCs in good working order. For basic
security, she advised having a good antivirus program
(one), a software firewall (one), a hardware firewall
(one), and antispyware programs (two). For those who
missed her handouts with specific recommendations,
Star will soon make them available on her website.

Star’s instructions on basic maintenance provided me a
challenge and a good use of time on a foggy day off. I
am now the proud (and somewhat confused) owner of a
new PC with Vista Home Premium, but I have retained
my old PC with Windows 98 SE to support some older
applications not compatible with Vista.

Encouraged by Star’s clear remarks on disk cleanup,
error checking, and defrag, I decided to try those
functions on the old PC. Her directions are based on a
Windows XP system, but they work approximately the
same on systems with Windows 98 SE or Windows ME.
Until now, I hadn’t completed a successful defrag on
the 98 SE system in the last four years.

First, I Deleted Unneeded/Obsolete Programs
Go to “Start,” “Settings,” “Control Panel,” and “Add/
Remove Programs.” On the “Install/Uninstall” tab, click
on a program name to select it, then click the “Add/
Remove” button. The program will either simply
uninstall, or an Uninstall Wizard will appear. Just follow
the prompts; if uncertain about removing “shared” files
when asked, leave them and continue. Of course, only
remove programs that you can recognize and are certain
you do not need.

MEETING
REVIEW

Carolyn
Lake
Vice
President/
Programs &
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Team
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Next, I Deleted Files that Accumulate in the
Background When I Use My PC
Go to “Start,” “Settings,” “Control Panel,” “Internet
Options.”  Under the “Temporary Internet Files”
heading, click the “Delete Files” button and “OK” the
deletion in the next window. The “Delete Cookies”
button allows you to delete all cookies. To inspect the
cookie list first, close “Control Panel,” then right click
on the “Start” button, left click on “Explore,” and in the
folder list, go to: “C:\Windows\Cookies.” Highlight the
files to delete and hit the “Delete” key.

Some cookies are useful, so you may wish to leave those
with your bank or brokerage name in the file name.
However, you can delete all cookies and the next time
you visit an important site, re-enter requested
information so that the site recognizes your computer.

With the folder list still visible, also go to:
“C:\Windows\Temp.” In the right hand window, locate
files ending in “.tmp.” These can be safely deleted; if a
message appears that a file is in use and/or cannot be
deleted, just skip that file and continue. To select a
number of files to delete, click once on the first file in a
group, hold down the “Shift” key, and then click on the
last file in the group. All files in between are selected;
hit the “Delete” key.

Then I Emptied the Recycle Bin
Right click on the recycle bin icon, and then left click
on “Empty Recycle Bin.” Also, if a screen saver program
is used, turn it off by going to “Start,” “Settings,”
“Control Panel,” “Display,” and on the “Screen Saver”
tab, set the selection to “None”; click “OK.”

Then I was Ready for the Main Cleanup Work
It’s best to start this part when the computer isn’t needed
for several hours, as defrag especially may take a while.
Star advised doing these operations in Safe Mode. To
enter safe mode, go to “Start,” “Restart,” and when the
computer has shut down and is starting up again, while
the screen is black, tap the “F8” key lightly a few times.
A list of choices appears; use the keypad arrow keys to
select “Safe Mode” and then hit the “Enter” key. When
back on the desktop:

For Disk Cleanup: Double-click the “My Computer”
icon, right click the “C:\” drive, and left click on
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“Properties” on the fly-out menu. Click the “Disk
Cleanup” button, check the types of files to clean if
prompted, and then click “OK,” then “Yes.”

For Error Checking (SCANDISK): After performing
“Disk Cleanup,” check the “Tools” tab in the same
window. Under “Error-checking status,” click the
“Check Now” button. Select either “Standard” or
“Thorough” cleanup, and click the “Start” button.

For Defragmentation: When “Disk Cleanup” is
completed, on the “Tools” tab under “Defragmentation
status,” click the “Defragment Now” button and let it
run! Take a break, have coffee, read a book … this could
take some time. My old system took several hours, with
the program restarting itself several times, but it finally
got though! When all is finished, restart your computer
and it will come up in Normal Mode.

Of course, a system guru would find many more things
to check, but I was very satisfied with the result of these
few simple operations. Moreover, it was fun to apply
practically the good tips from Star at an MBUG
meeting.�                                    lakelyn@comcast.net

CONGRATULATIONS AND
THANK YOU!

After the May General Meeting
presentation by Brynn Birtwistle,

Smart Computing Representative, a
number of MBUG-PC members either

subscribed for the first time or renewed
their subscriptions to what we think is the best
all-around computer magazine. Because of our
special relationship with Smart Computing, our
score in the “Buy-Five-Get-One-Free Program”

is:
�7 Subscription Credits Carried over from 1st

Quarter of 2007; �15 Subscription Credits
Earned during 2nd Quarter of 2007; �22 Total

Credits and 4 FREE SUBSCRIPTIONS!

Many thanks to everyone who subscribed and
provided credit to MBUG. The free subscriptions
will be raffled off at future meetings, and proceeds
will go towards our educational activities.

TO SUBSCRIBE TO SMART COMPUTING
To subscribe to Smart Computing with credit to
MBUG go to www.mbug.org, click on the Smart

Computing banner (bottom left). On the left
(blue), click “User Groups”; on the right

(yellow), click “Subscribe or Renew Today!”
Select Smart Computing magazine and complete

the rest of the form; under “Give your group
credit for your order! User Group:” select

“Monterey Bay User Group - PC, Inc. - Pacific
Grove, CA.” Complete the form and “Send.”

All subscriptions count—members, non-
members, gifts, etc., as long as you give credit to

MBUG. You’ll get an great, easy-to-read,
informative magazine!�blacklion@royal.net

STAY UPDATED SO WE CAN UPDATE YOU!
Have you updated your MBUG membership
information lately? If you have a new e-mail
address, phone number, or address we may
not know about, please contact Membership

Chairman Tom Streeter at
tom223@pacbell.net or call 657-4249.

GENERAL MEETING
RAFFLE PRIZES

Get Lucky on August 3rd
�Adobe Photoshop CS Software

with Users Guide
and Reference Books

(Photoshop CS Studio Techniques, Classroom In
A Book, and One on One)

� Smart Computing Magazine
(one year subscription)

� “Fix Your Own PC” from the Smart
Computing Reference Series

�... and more!

Donations in cash, and of software, equipment or
supplies for raffle are also welcome!

Contact lakelyn@ixnetcom.com
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BOOK
REVIEW

Regina
Doyle
MBUG-PC
Newsletter
Editor

40 Digital Photo
Retouching Techniques

with Photoshop Elements
by Zach Lee

Third Edition 2007
ISBN 978-89-314-3370-8

“Youngjin Go Digit@l Series”
  200 pages, $16.99

(available at a 35% discount
from O’Reilly Publishing to

MBUG Members:
see page 8 for details)

I got this nifty little book from
O’Reilly Media as an unsolicited
surprise in the mail about two
months ago. I suppose I must be on
someone’s list since I’ve reviewed a
couple of O’Reilly publications in
the past. Anyway, since I don’t do
very much with Photoshop
Elements, I just kind of flipped
through the book and made a mental
note of what was in it. I thought:
“Well, I have no obligation to review
it since I didn’t ask O’Reilly to send
it to me.” I just sort of glanced at it.

But the book is full of great color
before-and-after photos on every
page, which made it easy to read and
understand, even though I wasn’t
studying the step-by-step
instructions closely. I made a rapid,
superficial assessment of each
technique, and rated them as follows:
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“Useless”—I couldn’t think when I
would ever have a reason to touch
up a photo in this manner, e.g.,
brightening up a specific spot;
completely changing a color of an
object (say, turning a blue car into a
red one); colorizing black and white
photos; applying makeup to a face;
creating bigger eyes and a sharper
chin; separating scanned images;
adjusting image shape and size;
adding motion blur; and adding
snowfall.

“Might Possibly Come in
Handy”—I thought I wouldn’t have
too much use for these touchup
techniques, but they looked
interesting, e.g., correcting
backlighting; creating a sepia-tone
picture; opening closed eyes;
altering perspective; and combining
images.

“Wow, That Looks Like a Good
Trick”—I thought if I ever did any
photo retouching, I might give these
a try (e.g., removing red eye;
removing facial blemishes; cleaning

up backgrounds; adding type effects;
and stitching panoramas).

I made my rapid evaluation, put the
book on my reference shelf, and kind
of forgot about it. That is, until last
week, when I got copies of some
photos from my friend Doris Uyeda,
who is an absolutely wonderful
digital photo snapping maniac! Four
of us took a trip to San Francisco’s
Japantown and she took pictures of
us in front of shops, monuments, and
fountains, eating lunch, shopping,
strolling, and looking at exhibits at
the SF Asian Art Museum.

One very cute picture was of
Tomoko Ogaki and myself posing
behind one of those painted plywood
cartoon figures (that you find
everywhere in Japan). This one was
of us as traditional “lucky cat”
figures, and would have been a great
photo except that, as you can see
below, Tomoko (on the right), had
her eyes shut. Like most people,
Doris didn’t stop to check every
photo she took  in order to do retakes.
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Digital Photo Retouching
Techniques to the Rescue!
I immediately thought of that
O’Reilly book and pulled it off the
shelf. I told myself I had a lot of work
deadlines to complete and should not
be even thinking about retouching
frivolous photos when I’m so busy.
I was sure this was going to eat up
hours of my time and be very hard
to learn, but I just had to take a peek.

What I needed, in addition to my
“closed eyes” photo, was another
photo of the same person in
generally the same position (e.g. in
both photos the person is looking
forward, or both in three-quarters
profile, or both from the side, etc.).
The headshot didn’t have to be at
exactly the same angle, contrast, or
distance, but I knew these factors
would help make retouching easier.

Fortunately Doris supplied me with
a good shot of Tomoko looking
forward with her eyes open, as seen
below: that’s Katie Potter, me and
open-eyed Tomoko having lunch.

Here are roughly the steps I followed
using Chapter 3: Enhancing
Portraits - Section 19 Opening
Closed Eyes (page 98):

1. Open both photos on the same
page in Photoshop Elements.

2. Select the “Lasso” tool and set the
“Feather” feature to 7 pixels.

3. “Lasso” the open eyes.

4. Select the “Move” tool from the
toolbox. Click and drag the “open
eyes” on top of the “closed eyes”
photo.

5. Select “Image > Rotate > Flip
Layer Horizontal” to flip the open
eyes if needed. (I figured out on my
own that you only do this if your
“open eyes” are oriented slightly in
the opposite direction of your
“closed eyes” face).

6. Select “Image > Transform > Free
Transform” from the menu bar.

7. Place the pointer over a handle of
the “Free Transform” bounding box,
hold down the “Alt” and “Shift” keys
and drag and skew until the “open
eyes” fit the “closed eyes” face.

8. Zoom in and use the “Move” tool
to further adjust the position of the
“open eyes”.

9. If the new “open eyes” are brighter
than the rest of the image, use
“Enhance > Adjust Lighting >
Levels” to darken the new eyes. (I
had the opposite problem from the
example in the book: my “open
eyes” were darker than the rest of
the “closed eyes” image, but I
figured out how to use the “Adjust
Lighting Levels” to remedy it).

10. Select the “Eraser Tool” from the
toolbox. In the options bar, set “Size”
to “30 pixels” and “Opacity” to
“50%”.

11. Use the “Eraser” tool to erase as
much of the skin as possible, leaving
the eyes untouched.

12. Zoom out to check the whole
image. (And, as I assumed, adjust as
needed).

13. Select “Layer > Flatten Image”
from the menu bar to combine the
two layers into one.

Following the above instructions, I
managed to retouch the original
photo in about half an hour! I think
the final results (on the opposite
page) were amazingly good for a
first try, don’t you?

As you may also notice, I was so
thrilled by the results that I went on
to crop the photo, fill in the missing
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(NF)

corners of the plywood cutout, erase
the graffiti on the top left corner, and
(ahem), give myself a little face lift
(ironed out a few wrinkles).

Obviously I revised my opinion
about “40 Digital Photo Retouching
Techniques with Photoshop
Elements,” and the usefulness of
each technique. I found that it has a
nice introductory chapter (“Warming
Up to Photoshop Elements 5.0”)
which explains key features,
understanding pixels, resolution, and
file formats, and a tour through the
welcome screen, and editor and
organizer windows.

My only complaint is that the step-
by-step instructions focus very

narrowly on how to achieve specific
results for the illustrated sample (a
practice CD for which comes in a
pocket in the back cover). I wanted
a general how-to-use guide for each
tool, but that’s asking too much from
this otherwise wonderful little book!

Thanks to Zach Lee for great tips,
clear layout and easy-to-understand
writing. And thanks to whoever at
O’Reilly Media sent this to me!

Interested in getting a free book in
exchange for writing a review? Read
the next column on this page, visit
the O’Reilly website, choose a title,
and contact Jack Lewtschuk.�

ReginaDoyle@aol.com

Original
“closed eyes”
Tomoko (left),
was blended
with “open

eyes”
Tomoko

(middle) ...

... to become
the final

version of
“open eyes”

Tomoko
(right), using
Photoshop
Elements.

O’Reilly
New
Releases:
Books,
Short Cuts,
and Rough Cuts
Did you know you can request a
free book or PDF to review for the
MBUG Newsletter? Ask Jack
Lewtschuk, O’Reilly Liaison,
for more information at
blacklion@royal.net  or call (831)
757-0123.

For book review writing tips and
suggestions, go to http://
ug.oreilly.com/bookreviews.html.
A Few of the Newest Titles
•iPhone: The Missing Manual
•3ds Max 9.0 (Young Jin)
•Dreamweaver CS3: The
Missing Manual
•Dynamic Learning: Photoshop
CS3
•Excel Hacks, Second Edition
•Learning Flash Media Server 2
•Learning Web Design, Third
Edition
•Low Budget Shooting (Hard
Cover) (Rocky Nook)
•Music Projects with Ableton
Live (PC Publishing)
•Network Warrior
•Photoshop CS3
Photographer’s Handbook
(Rocky Nook)
•Photoshop Lightroom
Adventure
•Podcasting Tricks (Pragmatic
Bookshelf)
•Windows Vista Accelerated
(Young Jin)
•Windows Vista Administration:
The Definitive Guide�
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1 yr 2 yrs 3 yrs
Computer Games $15.95  ——  ——
Computer Gaming World $14.95 $28.95 $41.95
Computer Shopper $16.97 $32.95 $47.95
Dr. Dobbs Journal $15.95  ——  ——
Mac Addict $10.97 $19.97 $28.97
Mac Life $10.97   $
Maximum PC $9.95 $18.95 $27.95
Microsoft System Journal $21.95 $39.95      ——
PC Gamer $12.95 $23.95 $33.95
PC Magazine (22/44/66 issues per yr.)

$25.97 $48.95 $68.95
PC World $16.95  ——  ——
Videomaker $11.95 $21.95  ——
Wired $10.00 $18.00  ——

For over 300 more titles, contact Herb by e-mail.
Prices are for new subscriptions & renewals. Send

check, cash or money order payable to:
Herb Goodman 8295 Sunlake Drive, Boca Raton
FL 33496 / phone (561) 488-4465 / hgoodman@

prodigy.net. Allow 10 - 12 weeks for magazines to
start. Renewals: Send address label from your

present subscription to ensure correct start.
Herb will mail a renewal notice 4 months prior to

expiration date.

HERB GOODMAN DISCOUNT
COMPUTER MAGAZINE PRICE LIST

Our Members can now get a 35% discount on
all books from O’Reilly as well as their “No

Starch”, “Paraglyph”, “PC Publishing”,
“Pragmatic Bookshelf”, “Sitepoint”, “Syngress”

and “YoungJin” publications. Use the same
code “DSUG” when ordering books online or
by phone at 1-800-998-9938. We still get free
ground shipping on orders of $29.95 or more
(in the US). Go to www.oreilly.com/store/ and

see what’s new!

O’Reilly catalogues are available at general
meetings.

 Want to know
more?

Contact:
Jack Lewtschuk

 blacklion@royal.net

FREE tech support
to both subscribers and non-subscribers.

1 (800) 368-8304 Mon-Fri 7am to 8pm CST
Saturdays from 8am to 4pm CST (Nebraska time)

or any time on the Internet:
webhelp@smartcomputing.com  or

www.smartcomputing.com

Subscribe to Smart Computing and benefit
MBUG-PC: use source code 8181 when ordering

and for every five subscriptions, we get one free for
our raffle to fund our educational activities.

12 issues for $29.00 / 24 issues for $48.00
36 issues for $64.00

To subscribe and renew with credit to MBUG,  follow
the instructions on page 6 in this issue.

Smart Computing

UPDATE:
MBUG-PC
Members
now get

35% off all

Go Green, Give to Charity,
Support Local Industry

Recycling empty computer ink cartridges through
MBUG helps prevent non-degradable plastic and
metal waste from polluting our landfills. At the
same time we make money for our educational

programs by selling them to a local (Monterey) ink-
refill company. We make it easy for you, too: just
drop your empties (any brand, any type) into the
brown box or give them to any Board Member at

General Meetings or workshops.�
ellias@msn.com

RECYCLE INK CARTRIDGES

O’Reilly Books and PDFs!

A TIP FROM JACK: Before subscribing or
renewing through the above, check if the

publisher has a current special price (which
happens periodically). � blacklion@royal.net
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�Jim Anway
STRICTLY  Wednesdays & Fridays

from 2pm to 5pm at 625-5618
�Lee Keely

Prefers e-mail at Lee@leekeely.com
or call 626-8033
�Bob Stephan

e-mail to stephan.bob@gmail.com
or call only between 9am-5pm

646-1373
�Clive Sanders

e-mail to simbacli@pacbell.net
or call only between 1pm to 9pm

phone (831) 375-5376 �

Computer Help - Just a Click or Call Away with MBUG F1
You know you push the  ‘F1’ button on
your computer when you need help.
But do you also know that  you can call
or e-mail MBUG-PC “F1 for Help”
with your computer questions?

Our expert team of F1 Volunteers will
share their experience on software and
hardware. To get computer help:

(1) Contact any of the people listed
below; or
(2) Ask questions during any MBUG-PC
meeting break or Q&A session; or
(3) Leave  Don Slaiter (831) 655-4443/
657-4154 a message; or
(4) Broadcast a message to all
members through the MBUG-PC
Listserv mbug@listserv.redshift.com)
in plain text only (NO html, please)!

See PGAEC catalog & web pages for
class descriptions.

Call: Computer Office  (831) 646-6657
or e-mail Bruce Cates: bcates@pgusd.org

http://www.pgusd.org

Vocational
Education
Computer

Classes

Pacific Grove
Adult
Education
Center

1025 Lighthouse Avenue
Pacific Grove CA 93950

“Learning for Life”
○

○

○

○

○

○
○
○
○
○
○

VOLUNTEER COMPUTER
COACHES/TEACHERS NEEDED

Sally Griffin Senior Center
in Pacific Grove

is in need of additional “computer coaches”
and instructors for their

Technology Access Program for Seniors.
The center provides older adults an

opportunity to learn and practice their
technical skills in a small lab, working one-

on-one and in a small class format.
If you have the time, ability and patience to
tutor beginners in a relaxed setting, contact
Andrea Fuerst at the Sally Griffin Senior

Center at (831) 375-4454 or e-mail
alcdir@mowmp.org

Services are free of charge
(with the understanding that MBUG-PC, its Board

of Directors, and the F1 Volunteers themselves are in no way responsible or liable for the
accuracy or the outcome of any advice or suggestions!)

F1            Jim           Lee          Bob        Clive
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Travel

� � � � � Dan Presser, Owner
26080 Carmel Rancho Blvd., Suite 103

Carmel CA 93923-8757  � � � � � (831) 622-0800
Fax (831) 622-9467 � � � � � CST #1000683-40

info@fourwindstravel.com

 MBUG-PC SUPPORTERS

James W. Anway
Retired IBMer
Computer Consultant

Phone: 831 625-5618
Fax: Call first

Star Reierson
star@computerpowerstar.com

FourWinds

1173 Ninth Street
Monterey CA 93940

Phone: (831) 373-3919
       Fax: (831) 373-0671

Where the good times begin
SM

Bob Weisensee
Production Supervisor

CREATIVE TECHNOLOGY
of Sarasota, Inc.
5969 Palmer Boulevard
Sarasota FL 34232-2841

bob@ctimls.com

Printer of the MBUG-PC Newsletter

(941) 371-2743 / FAX (941) 379-2933 / 1-800-533-1031

Dan Presser in Borneo discussing conservation
awareness with a local Headman.
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Cleaning House? Reorganizing? Getting A New PC?
MBUG needs new or gently used, working computer software, hardware, supplies, and

peripherals,  for fund-raising raffles (and cash donations too).
Call ahead to determine if your items can be put to use.

Contact Don Slaiter slaiter@pacbell.net

raffle items wanted
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How-to web-based mapping sites
can not only point you in the right
direction, but they can also give you
an idea as to whether everyone else
is heading in that same direction.

Real-time traffic updates on three of
the top online mapping sites—
Google Maps, Yahoo! Maps, and
Microsoft’s Live Search Maps—
are far from perfect, but they might
save you some time and aggravation
next time you plot your route
through the metropolis. In this
article, we take a quick look at what
these sites offer and how to use them.

Google Maps
Google Maps recently became the
latest web-based mapping site to add
live traffic conditions. Head to
maps.google.com and access traffic
data by clicking the “Traffic” button
next to the three other view buttons
in the upper-right corner. If you’re
zoomed way out, you’ll just see
traffic lights denoting cities where
traffic information is available.

Zoom in closer on one of those areas,
and you’ll see color-coded double
lines superimposed atop major
highways and other roads.
Generally, green means no
problems, yellow indicates slower
traffic, and red means there are folks
moving at less than 25 miles per
hour.

Gray lines mean no data is available
at the moment for those roads.
Unfortunately, there are a lot of gray
lines; how many depends upon the
city you’re viewing. Los Angeles for
example, was lit up like a red-and-
green Christmas decoration the day
we looked. Philadelphia on the other
hand, was almost entirely gray.

Microsoft Live Search
Point your browser to maps.live.com
to see Live Search Maps,
Microsoft’s feature-filled (at least
for Internet Explorer 7 users) map
site. Like Google, traffic information
shows up as color-coded lines that
represent roads after you click the
“Traffic” link at the top of the map.

Rather than Google’s bold lines,
Live Search Maps uses slightly more
subtle highlighting. Both look fine,
although Google makes it a bit easier
to tell which color belongs to which
side of the road.

Live Search Maps adds another layer
of data in the form of icons

representing accidents, construction,
and other incidents. Yellow, orange,
and red icons denote minor,
moderate, and serious incidents.

Hover your mouse pointer over an
icon and a pop-up window displays
a summary of information about the
incident.

Yahoo! Maps
Instead of lines or highlighting,
Yahoo! Maps at maps.yahoo.com
tacks small colored dots next to
roads that indicate the situation at
specific spots. The dots aren’t
always easy to find, and it’s hard to
tell how far heavy traffic extends
from either side of a red dot.

Like Live Search, Yahoo! Maps
includes icons pinpointing various
incidents, such as accidents and road
construction. In some jurisdictions,
however, incidents include a slew of
relatively minor events. Our
neighborhood had a few icons for
incidents that in reality wouldn’t
have slowed down any drivers.

my favorite
 WEBSITE
by Alan Phelps,

Smart Computing

Avoid Traffic with
Online Maps
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Unlike Live Search, Yahoo! Maps does not include a
way to remove all of the icons without turning off traffic
information altogether.

Jammed Up
Real-time traffic maps are great in theory, but there are
some limitations: most of the data is for freeways,
leaving other major roads out in the cold. Second, too
many roads simply report no data. We mentioned some
gray spots on the Google maps; Microsoft and Yahoo!
Maps exhibit the same problem.

Perhaps more troubling is the accuracy of the traffic data.
For instance, at one point Yahoo! Maps reported slow-
going on I-395 through Arlington, VA. Views of that
same road using various live traffic webcams, however,
showed  cars zipping along. A driver who decided to
avoid I-395 would only have wasted time. Another day,
Yahoo! Maps reported severe backups on highways
leading out of Washington, DC, whereas Google Maps
and Live Search showed clear, green color-coded roads.

In other words, what you see on the live traffic maps is
not always as up-to-date as it claims to be. Check your
favorite online map before you head out the door and
maybe even consider alternative routes, but don’t be
completely surprised if the situation on the ground isn’t
quite what the maps said it would be.�

Reprinted with permission from Smart Computing.
Visit www.smartcomputing.com/groups to learn what

Smart Computing can do for you
and your user group!

Jim Anway
Workshop Leader

Wednesday, August 22
7:00 to 9:00pm

Canterbury Woods
Auditorium, Pacific Grove

COMING in SEPTEMBER
DIGITAL RIGHTS
MANAGEMENT

AUGUST
ADOBE

PHOTOSHOP CS2

Jim will review some of the new tools in Photoshop
CS2 and provide tips and tricks for enhancing photos
old and new. For advance questions and information,
contact Jim at 625-5618 or e-mail
AnwayJ@comcast.net.�

Andy of Marken Communications will provide an
insider’s look at Digital Rights Management and what
it will mean for the industry and anyone who works with
a PC or watches videos, meaning everyone! Questions?
www.markencom.com or  andy@markencom.com.�

Andy Marken
Guest Speaker

Friday, September 14
7:00 to 9:00pm

Adult Education Center,
Pacific Grove

 

WINE NOTES 2.0 EVALUATION SOFTWARE
Jud Grubbs & Pat Landee, Guest Speakers
Wednesday, September 26,  7:00 to 9:00pm,
Canterbury Woods Auditorium

Interested in organizing wine by more than just “red” and “white”? Jud Grubbs and Pat Landee
of Groundspace Corporation, Pebble Beach, will demonstrate their product Wine Notes 2.0, a

wine evaluation and selection tool, for use by  the casual collector or connoisseur. Designed for
managing a wine cellar, the software runs on PDAs or PCs using Windows XP (soon to be Vista-
compatible). Interested? Contact Pat at 655-9907; pat@pinotnoir.com; or www.groundspace.com/.
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General Meeting Location
Adult Education Center, PG

1025 Lighthouse Avenue, Pacific Grove
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P.G. Adult Education Center
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Canterbury Woods
651 Sinex Avenue
Pacific Grove
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Hilltop Park Center
871 Jessie Street

Monterey
David Avenue (East of Hwy 68)

D
ivisadaro Irving Street

JESSIE

Archer

HILLTOP
CENTER

PARK x

 TO 68

Archer
Park:

N

1 2 3 4

5 6 7 8 9 10 11

12 13 14 15 16 17 18
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  Sunday   Monday   Tuesday    Wednesday    Thursday    Friday   Saturday

“Microsoft Office 2007”
Adult Ed Center PG

7:00 to 9:00pm
Debbie Jones

“Adobe
Photoshop CS2”

Canterbury Woods
7:00 - 9:00pm

Jim Anway

MBUG Holiday:
NO

WORKSHOP

DIRECTORS’ MEETING
Canterbury Woods PG

Begins at 7pm
Everyone Welcome!

JULY 31

1

2 3 4 5 6 7 8

9 10 11 12 13 14 15

16 17 18 19 20 21 22

23 24 25 26 27 28 29

30

Sunday Monday Tuesday Wednesday Thursday Friday Saturday

DIRECTORS’ MEETING
Canterbury Woods PG

Begins at 7pm
Everyone Welcome!

“Manage Wine Cellar w/
Wine Notes 2.0”

Canterbury Woods
7:00 - 9:00pm

J. Grubbs & P. Landee

“Digital Rights
Management”

Adult Ed Center PG
7:00 to 9:00pm
Andy Marken

MBUG-PC Calendar of Events - AUGUST  2007

Tentative Calendar September 2007 Check the September Newsletter for Final Schedule

LABOR DAY
HOLIDAY

MBUG Holiday:
NO

WORKSHOP
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PO Box 51611
Pacific Grove

California  93950

Vol 26, No 8, August 2007

Check your Membership expiration date above.
Does it say “Exp: August / 2007”?

If so, renew your subscription today!
Enjoy the many benefits of MBUG membership and don’t miss
an issue of this fine, locally-produced publication. Membership
& Newsletter Subscription: Electronic $20, US Mail $25, both $35.

Additional tax-deductible donations welcome! Send your name,
address, phone number, e-mail address & check to: Monterey Bay

Users Group-PC, Box 51611, Pacific Grove CA 93950
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PERSONAL COMPUTER

newsletter
 mbug-pc

MEMBERSHIP
REPORT

Membership
Chairman

WELCOME BACK, AND
THANK YOU FOR RENEWING
YOUR MEMBERSHIP

name       member number
Jim Anway ...............................841
Phil Butler ..............................1233
Martha Craig ..........................1065
Connie D’Attilio ....................1064
Joanie Hyler ...........................1295

Tom
Streeter

MBUG-PC is a member of
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30% DISCOUNT ON COMPUTER BOOKS
FOR MBUG MEMBERS

 The Peachpit User Group Partner Program gives hefty
discounts on books ordered online! Click the Bookstore
link at www.peachpit.com, to view books on graphics

applications, business productivity, operating systems,
digital lifestyle, and more. Discount at point of purchase

using group discount coupon code UE-23AA-PEUF
(case sensitive).

Interested in getting your hands a juicy new
computer book for FREE? Just write a short (or
long) review of a selected title of your choice,

from an extensive list at www.peachpit.com, and
have it published in the MBUG-PC Newsletter.
Examples at www.peachpit.com/usergroups.

Contact Carolyn Lake to have your book choice
sent to you. (831) 643-2023 or

lakelyn@ix.netcom.com

Review a PEACHPIT PRESS Book
& Keep it for FREE!

William G. Odom ..................1166
Bill Randolph.........................1237
Tom Streeter ..........................1062
Sarah Haller ...........................1105

THANK YOU FOR YOUR
GENEROUS DONATION
name       member number

Tom Streeter ...........................1062


